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Introduction 

 
The GPU MeshMapper simplifies the process of generating maps for a low-resolution mesh based on 

the details from a high-resolution mesh. This version of the tool has support for generating and 

visualizing normal maps, ambient occlusion maps, and displacement maps. The low-resolution mesh 

must have texture coordinates assigned to each vertex, and should ultimately be the mesh that will be 

used in your final application. The high-resolution mesh should contain all the detail that you want 

visible in the generated maps. 
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What’s New 

What’s New in GPU MeshMapper Version 1.2 

• Improved Ambient Occlusion Generation 

• Updated to use the latest ATI Tessellation library (require Catalyst 8.11 or greater). 

• Maintenance Release  

 

Overview of New Features in GPU MeshMapper Version 1.1 

Improved Texture UV Seams  

A new seam fixing algorithm reduces (or eliminates whenever possible) texture seams along texture uv 

boundaries.  Texture seams can be color discontinuities for color texture map, lighting seams for 

normal map or geometry cracks for displacement map.  This algorithm is performed automatically after 

map generation. 

Seamless Displacement Mapping 

 
Rendering a Soldier model with displacement mapping (with point-sampling) enabled.  Left: Using a 

displacement map generated with GPU MeshMapper v1.0.   Right: Using a displacement map 
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generated with GPU MeshMapper v1.1.  Notice the geometry cracks along uv boundaries in the left 

figure (the area inside the red circles). 

 

Improved Seams for Tessellation 

 
Rendering a Soldier model with displacement mapping and hardware tessellation enabled.  Left: Using 

a displacement map generated with GPU MeshMapper v1.0.  Right: Using a displacement map 

generated with GPU MeshMapper v1.1. Notice the geometry cracks along uv boundaries in the left 

figure (the area inside the red circles).  

 

A similar improvement is achieved for normal mapping with bilinear sampling. 
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Improved Support for Tangent Space Normal Map 

 
Rendering a Froblin model with tangent space normal mapping enabled.  Left: Using a tangent space 

normal map generated with GPU MeshMapper v1.0.  Right: Using a tangent space normal map 

generated with GPU MeshMapper v1.1.  Notice the visible lighting seams under the Froblin arm and on 

the upper part of the Froblin leg in the left figure.   

 

For your application/engine to achieve continuous tangent space along texture uv boundaries as 

shown in the right figure, you should use an orthonormal tangent frame matrix.  The formula for this 

matrix can be found in the Appendix A of Maya documentation for version 7.0 and above.  Note that 

our own Demo Team is not able to use Maya v8.5 to generate a tangent space normal map that 

produces a high rendering quality similar to the right figure above. 
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Improved Performance 

• Support for multi-core processors. 

• Improvements to internal algorithms (20% improvements). 

Our in-house testing revealed a 2.2x total speed up for generating 2048 by 2048 maps on a dual-core 

CPU. 

 

Improved User Interfaces 

• Preview options for the low and high resolution meshes will be saved in a project file.  It is now 

possible to set all your favorite settings in the preview options (for example, CW cull mode, 

wireframe, render with lighting, etc) and save these settings in a project file. 

• Camera settings will be saved in a project file.  It is now possible to set up a view for the mesh 

and save this view in a project file. 

• Added support for keyboard shortcuts. 

o A  Toggle Ambient Occlusion rendering for the low resolution mesh. 

o D  Toggle Displacement Mapping for the low resolution mesh. 

o E  Change camera to Pan mode. 

o R  Change camera to Rotate mode. 

o S  Toggle Stats. 

o T  Toggle Tessellation for the low resolution mesh. 

o W  Toggle wireframe mode (solid/wireframe) for the low resolution mesh. 

o Ctrl + H Load a high resolution mesh. 

o Ctrl + L  Load a low resolution mesh. 

o Ctrl + O Open a project. 

o Ctrl + Q Quit the app. 

o Ctrl + S  Save the current project. 

• Added a composite display for the preview window’s title.  The title has been updated from 

always displaying “Scene View” to a more descriptive text such as “Displaying Low Res Mesh 

with Displacement Mapping and Tessellation”. 

• Added a “pan” camera mode for the middle mouse button. 

• Added support to capture a screenshot (right-click the preview window and select Take 

Screenshot option). 

• Updated Stats display to show the number of triangles for the low, high resolution mesh and 

low resolution mesh after tessellation. 

• Added an ability to perform dilation post-processing in the Map Composer.  This is particularly 

useful for a mesh with multiple components.  Now, there will not be cracks/seams along 

texture uv boundaries using the maps generated by Map Composer. 

 

Improved Stability 

• Fixed bugs and memory leaks. 

• Improved support for generating 1K by 1K and 2K by 2K maps. 
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Other Features and Bug Fixes 

• The application will now only ask to save a project if one or more settings have changed. 

• Fixed support for 24 and 32 bits BMP file. 

• Fixed support for using negative numbers in a script. 

• Loading an obj file will no longer compute tangent vectors twice. 

• Fixed support for Collada files with multiple/hierarchical objects/meshes. 

• Added support for generating maps with multiple/hierarchical meshes. 

• Fixed support for composing maps back to back using a map composer script. 

• Fixed support for disabling displacement or ambient occlusion map generation using a script. 

• Fixed a bug that will crash the application if you generate maps after viewing and closing the 

map viewer. 

• Fixed a bug that will crash the application if you generate maps back to back especially for large 

maps. 

• Fixed a bug in the preview option UI. 

• Removed redundant UI display update calls.  

• Fixed support for using absolute and/or relative path in the script. 

• Fixed an error that will crash the application if the low resolution mesh contains texture 

coordinates that are outside of [0, 1] range.  Now, it will ignore the portion of the map that lies 

outside of the [0, 1] range and print a warning to the output window to notify the user. 

• Fixed a bug that will require an additional mouse click to transform the scene after selecting an 

option from the context menu. 

• Fixed a bug that will not render the scene properly if we turn off the normal map option and 

use an ambient occlusion map in the alpha channel. 

• Removed several unnecessary texture conversions. 

• The box filtering option has been removed. 

• Updated project, script and texture files. 

• Added animate light (a rotating light) for the scene.  This can be accessed by right clicking the 

preview window and select Animate Light from the context menu. 

• The application now links to DX9 March 2008 library. 
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Overview 
 

The GPU MeshMapper application is composed of 3 main parts: UI Panel, Preview Window and Output 

Window. 

 

The UI Panel is located on the left side of the screen and contains a tab controls to help load your low 

and high-resolution meshes, customize map generation settings, and modify the rendering 

visualization that is located in the Preview Window. 

 

The Preview Window consumes the majority of the window and displays the currently loaded mesh 

based on the display settings that are available through the UI Panel or through the context menus.  

 

The Output Window is located along the bottom of the window and displays the actions that are being 

performed along with error messages. 
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Example Process 
 

The outline below describes the typical map creation process. 

 

1) Load models. 

a. Load low resolution mesh by either: 

• Open the “File” menu. Select “Load Low Res Mesh…”. 

 

• Right click on the left half of the Preview Window and select “Load Low Res 

Mesh”. 

 

• Select the “Models” tab from the UI Pane open the “Low Resolution Mesh” 

roll-up control and click the “Load Low Resolution Mesh” button. 

 

b. Load high resolution mesh by either: 

• Open the “File” menu. Select “Load High Res Mesh…”. 

 

• Right click on the right half of the Preview Window and select “Load High Res 

Mesh. 

 

• Select the “Models” tab from the UI Pane open the “High Resolution Mesh” 

roll-up control and click the “Load High Resolution Mesh” button. 

 

2) Configure generation settings.  

a. Select the “Maps” tab within the UI Pane. 

 

b. “Common Settings” contains those settings which have an affect on all the maps that 

can be generated. 

 

c. “Normal Map” contains settings that only affect the normal map. There is no way to 

disable normal map generation. 

 

d. “Displacement Map” contains settings that only apply to the displacement map. 

Displacement map generation can be disabled, however it adds no additional processing 

time to generating the normal map. 

 

e. “Ambient Occlusion Map” contains those settings that affect the ambient occlusion map.  

Generating this map can be disabled if desired, as it can add significant processing time 

to the generation process; however it can be optionally accelerated using the GPU. 

 

3) Save your settings as a project file 
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a. Open the “File” menu and select “Save Project As…” to open a save dialog box that will 

allow you to store your project settings. This will store the path to the meshes you have 

loaded and the current generation settings. 

 

• Now you can easily reopen this project and have the models automatically 

loaded and your customized settings restored! 

• It will also store the low and high resolution mesh preview options from the 

“Preview” tab and the camera settings. 

 

4) Start the map generation process. 

a. Select the “Maps” tab within the UI Pane. 

 

b. Open “Common Settings”. 

 

c. Click the “Generate” button. 

 

5) Preview the resulting maps.  

a. After the maps are done generating, the Preview Window will automatically switch to 

rendering with lighting and the normal map applied. Previewing settings can be 

switched by either: 

 

• Right clicking in the Preview Window on the mesh that you’d like to visualize 

differently and selecting one of the available options. 

 

• Open the “Preview” tab in the UI Pane; open the roll-up control related to the 

setting you’d like to change, and make your selection from the available 

options. 

 

b. You can also view the textures directly using the Map Viewer, which can be accessed 

from the “Maps” tab within the UI Pane, then opening the roll-up control of the map 

you’d like to view and selecting the “View” button. 

 

6) Save the maps to disk for use in your own application. 

 

a. From within the “Maps” tab of the UI Pane there is a “Save” button located within each 

of the maps’ roll-up controls. Click on these buttons to save the corresponding map and 

to set the format the data should be stored in. 

 

• NOTE: Immediately after being generated, the maps are automatically stored 

in a 32-bit floating point texture format within the application’s directory. This 

uses a default filename for each map, so be sure to save them again with your 

own format and filename so they don’t get over written the next time you 

generate a map! 
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User Interface 

UI Panel 

 

The UI Panel window is the window on left side; it consists of three main tabs: “Models”, “Maps”, and 

“Preview”. 

 

 
 

 

Models Tab 

 

The “Models” tab allows you to load high and low resolution meshes and reports the number of 

vertices and triangles in each mesh and statistics about the mesh’s bounding box. 

 

 

  

 

 

 

 

 

 

 

 

 

 

Click here to load mesh from disk 

Displays the path name for the mesh 

 

Click here to collapse \ expand the options 

• BoundBox is the extent of the 

mesh. 

 

• Vertex & Triangles shows how 

many vertices and triangles 

make up this mesh. 

 

• Currently, data can be loaded 

from NMF, OBJ, and DAE file 

formats. 
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Maps Tab / Generation Settings 

 

The “Maps” tab contains all the settings needed for map generation, loading, and saving. 

There are four sections contained within this tab; each will be described in detail below. 

 

 

Common Settings 

 

 
 

 

 

 

Settings located here affect how all the 

maps will be generated.  

 

• The Generate button activates the map 

generation process based on the 

specified settings. While maps are 

being generated, a progress bar will 

appear that allows you to cancel the 

generation process. If you’d like to 

minimize the main window during this 

time, right click on the task bar and 

select “Minimize”. 

 

“Texture Dimensions” indicates the 

dimensions of the resulting maps. 

  

• Width specifies the width (in texels) of 

all generated maps. 

• Height specifies the height (in texels) of 

all generated maps. 

 

“Mesh Correlation” contains the settings 

that control how the correlation between 

the low and high-resolution meshes is 

found. 

  

• Max Distance specifies that a point on 

the high-res mesh must be closer than 

this distance to a point on the low-res 

mesh in order to be considered as a 
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correlating point. A surface that is 

further than this distance away will 

not be considered as a matching 

point. This value is in the same units 

as the high-res mesh. 

If cleared, and “Auto” is shown, then 

a distance of 50% of the shortest 

bounding-box dimension will be 

used (ex, if you the model is 

60x100x80, then “Auto” will be 

calculated as 30). 

 

• Max Angle the number of degrees 

within the low-res normal that a 

high-res normal must be in order to 

be considered as a correlating point. 

A Max Angle of 180 degrees (or 90 

degrees in any direction) will 

prevent back-facing surfaces from 

being considered. 

 

Given a set of correlating points on the 

high-res mesh, the following settings 

indicate how the choice is made 

between them: 

 

• Overall Closest selects the point 

that is the shortest distance to the 

low res mesh considering surfaces in 

front and in back. 

 

• Overall Farthest selects the farthest 

point away from the low-res mesh 

considering surfaces in front and in 

back. 

 

• Front Closest, then Back Closest 

first searches in front of the low-res 

mesh and selects the closest surface. 

If no surfaces are found in front, 

then it searches for the closest 

surface behind the low-res mesh. 

 

 

• Front Farthest, then Back Closest first 

searches in front of the low-res mesh 

and selects the farthest point away. If 

no points exist in front, selects the 

closest point behind. This is similar to 

the outer-most point. 

 

• Favor Low-Res Normals: select the 

point whose normal is closest in 

direction to the low-res normal if the 

two points in question are equidistant 

from the low-res surface. 

 

“Super Sampling” controls how many 

points per texel will be mapped to the 

high-resolution mesh. 

 

• Samples Per Texel controls the number 

of points within each texel for which a 

correlating point on the high-res mesh 

will be found. For example, if set to 2, 

2x2 samples will be taken and the 

result will be an average of them. 

 

• When Sample Texel Corners option is 

ON, 4 extra samples (one at each 

corner of the texel) are added for the 

correlation search. 

 

“Post Generation Fix-Up” contains 

processes that take place after the maps 

are generated to clean them up for final 

use. 

 

• Expand Texels controls how many 

passes of dilation happen in a post 

process. This expansion will reduce 

artifacts along UV seams when 

rendering uses non-point sampling  

( linear/trilinear/anisotropic ) and/or 

mip-mapping. 
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• Null Samples are texels for which no 

corresponding point on the high-res 

mesh could be found. If Low-Res 

Mesh Data is selected, these texels 

will be filled with the data from the 

low-res mesh. When Interpolated 

Neighbors is selected, these texels will 

be intelligently filled with data from 

the neighbors that were not Null 

Samples. This option tends to yield 

much better (smoother) results when 

Null Samples occur. 

Normal Map 

 

 
 

• Normal Space controls the space 

that the normal map is generated in: 

 

• TANGENT – Map will be in 

mesh’s tangent space. 

 

• WORLD     – Map will be in world 

space coordinates. 

 

• Bend Normal will cause the normals 

to be slightly angled in the direction 

that most light will be received from. 

This calculation is similar to the 

ambient occlusion calculation and 

can be done for free if you are 

generating an ambient occlusion 

map. 

 

• Add Detail Map: when selected, the 

loaded detail map will be applied to 

the generated normal map. 

 

• Scalar: a float value that will be 

multiplied by the detail map 

prior to applying it to the normal 

map. 

 

• Load: click this button to load 

the detail map. The path of the 

loaded map will appear in the 

field to the right. 
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Displacement Map 

 

 

 
 

 

 

 

 

 

 

 

• Generate Displacement Map 

enables the displacement 

calculation. 

 

• Desired Scale: a float value that 

specifies the scale what will be 

used with the displacement map. 

This value will be used to scale 

the resulting values correctly. If 

the field is cleared and “Auto” is 

shown, the actual resulting scale 

will be calculated and reported 

for use in the rendering shader. 

  

• Desired Bias: a float value that 

specifies the bias that will be 

used with the generated 

displacement map. This value 

will be used to shift the resulting 

values accordingly. If the field is 

cleared and “Auto” is shown, the 

actual resulting bias will be 

calculated and reported for use 

in the rendering shader. 
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Ambient Occlusion Map 

•  

 

 
 

 

 

 

 

 

 

 

 

 

• Generate Ambient Occlusion Map 

enables the ambient occlusion 

computation. 

 

• When Accelerate using GPU is 

ON, normal mapper will use 

graphics card GPU processing 

power to accelerate ambient 

occlusion computation. 

 

• Sampling Rate will control the 

number of occlusion samples 

that are taken when calculating 

ambient occlusion. Quality goes 

higher as the slider control goes 

right (and processing time takes 

longer). 

 

• Max Occlusion Distance 

specifies the maximum distance 

between two objects such that 

one object will still be 

considered to occlude the other. 

This setting is disabled if the 

ambient occlusion calculation is 

accelerated using the GPU. 
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Map Loading, Viewing, Saving 

 

Each of the “Normal Map”, “Displacement Map”, and “Ambient Occlusion Map” 

sections of the “Maps” tab have controls that also allow you to load a pre-existing map 

for visualizing and saving (or for saving the map that was just generated). 

 

 

 
 

• Load… Press this button to open an 

existing map from file for 

visualization or resaving. 

 

• View: Once a map is generated or 

loaded, clicking this button will open 

the MapViewer to allow you to view 

the actual texture. 

 

• Save: Once a map is generated or 

loaded, clicking this button will open 

a dialog box that allows you to save 

the associated map and specify the 

format that you’d like the values to 

be stored in; both unsigned int and 

float formats are supported with a 

variety of components and bits per 

component. Currently supported 

image types include TGA, JPG, DDS, 

BMP, and TIFF among others. 

 

• “Format” shows the current format 

of the map. Ex. A8R8G8B8 means  

8 bits each for alpha, red, green, and 

blue channels. 

 

• “Size” shows the dimension of map 

(in texels). 

 

• “# of mipmaps” shows how many 

mipmap chains were created for the 

map (including the top level). 
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Map Viewer 

 

 
 

When you click on “View” from the Map section in the UI Panel, the Map Viewer 

window appears. This window can be resized for better viewing. 

 

• Properties contains the format, dimensions, and # of mipmaps in the texture. 

When the viewer is set to display a displacement map, the scale and bias that 

should be used with the map is also displayed. 

 

• Display controls which texture is displayed in the window. By default the normal 

map is displayed, but if they are available, the ambient occlusion and 

displacement map can also be shown. 

 

o Normal Map shows the normal map as color (xyz are encoded as rgb). 

 

o Ambient Occlusion shows the ambient term gray-scale (darker texels are 

more occluded and brighter texels are less occluded). 
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o Displacement shows the displacement map as a gray-scale image. (darker 

texels are displaced less than brighter texels). 

 

• If Fit to screen is set, the texture will be scaled to fit inside the viewing window 

to the right. Otherwise, the texture will be displayed in actual size (without 

scaling); in this mode, you can either use the scroll bars or click and drag to move 

around the image. 

 

• Mipmap allows you to change which mip-level is displayed and reports the 

dimensions of the currently displayed mip-level. 
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Preview Tab 

 

The “Preview” tab allows you to change the way that the scene is rendered in the 

Render Preview window. You can select and tweak the background color, load a skybox, 

load a texture to apply to the models and modify the low and high res mesh rendering 

options. 

 

 

 

Background Section 

 

“Background” section contains controls to modify the background color.   

 

 
 

 

 

 

 

 

 

 

• Red: You can tweak the red value by 

entering a color value (0 to 255) or 

adjusting the slider. 

 

• Green: You can tweak the red value 

by entering a color value (0 to 255) 

or adjusting the slider. 

 

• Blue: You can tweak the red value 

by entering a color value (0 to 255) 

or adjusting the slider. 

 

• Pick Color… Press this button to 

bring up color dialog which will 

allow you to see the colors and 

make a selection more visually. 

 



© 2006–2008 Advanced Micro Devices, Inc. All rights reserved. 23 

Environment Map Section 

 

The “Environment Map” section allows you to load a cubemap and toggle whether or 

not it is used in the preview window. 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

• Click on Load to load a cubemap 

texture from disk as an environment 

map. When a map is loaded, this 

same button will read “Unload” and 

can be clicked again to unload the 

map. 

 

• If Display As SkyBox is checked, the 

preview window will render the 

loaded cubemap texture as a skybox. 

 

• Click on Save to save cubemap 

texture to disk. 

 

• Click on View to bring up SkyBox 

Map Viewer window. 

 

• Format shows the cubemap’s 

format (Ex. A8R8G8B8 means  

8 bits each for alpha, and rgb 

channels). 

 

• Size shows the dimensions of the 

cubemap faces (in pixels). 

 

• # of mipmaps shows how many 

mipmap chains are present in the 

cubemap. 
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Environment Map Viewer 

 

 
 
When you click on “View” from the “Environment Map” section in the UI Panel, the 

Environment Map Viewer window appears. This window can be resized for better 

viewing. 

 

• Properties constrains the format, dimensions, and # of mipmaps in the texture. 

 

• Display controls whether the color (RGB components) or alpha channel is 

displayed in the window. 

  

• If Fit to screen is set, the texture will be scaled to fit inside the viewing window 

to the right. Otherwise, the texture will be displayed in actual size (without 

scaling). 
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• Within the Mipmap area, you can change which mip-level is displayed and see 

the dimensions of the currently displayed mip-level. You can also choose which 

faces of the cubemap you would like to view; either All Faces can be viewed, or a 

specific face ( either +y, –x, +z, +x, –z, or –y ). 

 

Low Res / High Res Mesh Rendering Sections 

 

 

 

 

This section controls how the low and high resolution meshes are rendered in the 

preview window. 

 

• Cull CW culls clockwise specified geometry with respect to the current view. 

 

• Cull CCW culls counter-clockwise specified geometry with respect to the current 

view. 
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• Point Mode will render the mesh with a point for each vertex. 

 

• Wireframe Mode will render the mesh in wireframe. 

 

• Solid Mode will render solid triangles. 

 

• View TexCoord will color the mesh with its texture coordinates ( uv -> rg ). 

 

• View Tangent will color the mesh based on its tangent vector ( xyz -> rgb ). 

 

• View Binormal will color the mesh based on its binormal vector ( xyz -> rgb ). 

 

• View Vertex Normal will color the mesh based on the vertex normals ( xyz-> 

rgb ). 

 

• View Normal Map if a normal map is available, it will be applied to the mesh as a 

texture, so that you can visualize the xyz values of the normal map as an rgb 

color. 

 

• View Displacement Map if a displacement map is available, it will be applied to 

the mesh as a texture and the displacement value will be encoded as a gray-scale 

color. 

 

• View Ambient Occlusion if an ambient occlusion map is available, it will be 

applied to the mesh as a texture and the ambient term will be encoded as a gray-

scale color. 

 

• Render with Lighting will render the mesh using the phong lighting model 

o Apply Specular specular lighting will be enabled. 

 

o Apply Base Map if available, the base map will be applied to the mesh. 

 

o Apply Environment Map reflection of environment will be applied. 

 

o Apply Normal Map if available, normals from the normal map will 

replace the interpolated normals used for lighting. 

 

o Apply Ambient Occlusion if available, the ambient term from the 

ambient occlusion map is applied. 
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o Apply Displacement if a displacement map is available and hardware 

allows it, vertex positions will be adjusted based on the displacement 

map. 

 

o Apply Tessellation if the GPU in your machine supports tessellation and a 

displacement map is available; this enables tessellation of the low-res 

mesh. Also “Apply Displacement” to get the full effect of tessellation. 

 

� Tessellation Factor If tessellation is applied, the level of 

tessellation can be changed by either entering the level in the text 

box or adjusting the slider control.  
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Preview Window 

 

The preview window provides a quick and easy way to visualize the meshes that are 

being used to generate the maps and enables you to immediately view the results 

applied to the low-resolution mesh. This is useful for being able to quickly decide 

whether you want to make changes to the generation parameters and regenerate the 

maps, or if they should be saved for use farther down your tool chain. 

 

NOTE: When both meshes are being previewed the view is setup based on the union of 

the meshes’ bounding volume. If both meshes exist in the same world-space (and they 

should) then both models will appear centered.  When a single model is being 

previewed (as shown below), the view will be adjusted for that particular model.  
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    From left: Display low res mesh. Display high res mesh. Display both 

meshes.  

 

If you click the currently selected button a second time (to depress it), neither of the 

meshes will be displayed. This is useful if you have loaded large meshes and rendering it 

causing the application to respond slowly. Selecting one of the buttons again will display 

the corresponding mesh(es). 

 

    From left: Rotate, Pan, Slide, Zoom UI mode. 

 

    Reset camera to default position. 

 

Keyboard Shortcuts 

• A  Toggle Ambient Occlusion rendering for the low resolution mesh. 

• D  Toggle Displacement Mapping for the low resolution mesh. 

• E  Change camera to Pan mode. 

• R  Change camera to Rotate mode. 

• S  Toggle Stats. 

• T  Toggle Tessellation for the low resolution mesh. 

• W  Toggle wireframe mode (solid/wireframe) for the low resolution  

mesh. 

• Ctrl + H Load a high resolution mesh. 

• Ctrl + L  Load a low resolution mesh. 

• Ctrl + O Open a project. 

• Ctrl + Q Quit the app. 

• Ctrl + S  Save the current project. 
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Context Menus 
 

 
By left-clicking in the Preview Window, context menus will appear to help you easily 

modify the preview window. 

 

The first four options will remain constant and can affect both the low and high res 

mesh previewing. 

 

The remaining options will differ depending on whether you click in the low-res mesh 

rendering window or in the high-res mesh rendering window. These options provide you 

quick access to the options in the Display Tab of the UI Panel. 
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Output Window 

 

 

The Output Window will display any errors or notifications that may be important, along 

with the start and end time of map generation. 

 

This window can be closed via the View menu. 
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Menu Options 

 

The available menu options are:  

 

File 

 
Allows you to load and save project files. 

By selecting “Save Project As”, you can 

also save the settings as a script which 

can be used for command-line map 

generation. This menu also lists the 5 

most recently opened project files, 

allows you to load low and high 

resolution meshes, and allows you to 

exit the application. 

 

View 

 

Status Bar allows you to show / hide the 

status bar at the bottom of the 

application. 

Output Window allows you to show / 

hide the Output Window. 

 

Tools 

 

The menu contains additional tools that 

can assist you with the maps you’ve 

generated.

 

Map Composer 

 

The Map Composer allows you to combine multiple maps of a particular type (Normal, 

Displacement, or Ambient Occlusion) and can normalize the composite map into a single 

scale and bias.  

 

This tool is particularly useful when trying to generate maps for a complex object (for 

example, a character in a game) which may need to be separated out into individual 

pieces for the maps to be generated properly. This allows maps to be generated 

separately for arms, legs, bodies, and accessories, and then be properly combined into a 
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single map rather than having to manually paste them together. Manually combining 

displacement maps would require additional care to keep the scale and bias values the 

same for each generated map, or to be manually corrected when combining the maps. 

Fortunately, the Map Composer was designed to perform these tasks for you. 

 

Similar to the map generation, the Map Composer allows you to perform Expand Texels 

(how many passes of dilation) on the generated maps. 

 

When saving generated maps, an additional “*_mask.dds” texture is saved that is used 

by the Map Composer to identify where the important information is stored in the 

texture. These masks do not include the areas that may have been dilated as a post 

process (to prevent overwriting one texture’s important data with the dilated 

information from a second texture). Normal maps are assumed to have a scale of 2 and 

a bias of -1 and ambient occlusion maps are assumed to have a scale of 1 and a bias of 0. 

Displacement maps, which can have any scale and bias, are saved with an additional 

“*.txt” file that contains the maps scale and bias values. The Map Composer 

automatically loads this file when you are compositing displacement maps and uses the 

data to dynamically adjust the scale and bias of the final composite map. These final 

scale and bias values are displayed in the “Stats” section of the window. 
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Maps do not have to be saved in the same internal format in order for them to be 

combined and they do not have to be of the same file type.  The only constraint on the 

textures is that they need to have the same width and height. 

 

When saving a composite map, the same options are available as when the maps are 

saved after generation. So the maps can be generated and saved in one (or more 

internal formats) and then can be resaved to a different internal format (or file type) 

after map composition. Saving will also output an additional mask texture for the 

composed map and a text file containing the scale and bias if the composed map is a 

displacement map. 

Help 

 
 

The Help menu provides access to the “About GPU MeshMapper” dialog. 
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Running in Script ( Command Line ) Mode 
 

GPU MeshMapper has a scriptable interface that allows you to generate maps from the 

command line. The scripts can be used to control both map generation (MeshMapper 

Scripts), and map composing (MapComposer Scripts). Although their descriptions are 

separated out below, a single script can contain both types of commands. MeshMapper 

Scripts can be saved from within the application using the “File” -> “Save Project As…” 

menu option and selecting “MeshMapper Script File (*.nms)” as a file type. 

MpComposer Scripts must be authored manually. 

 

To run GPU MeshMapper in command line mode, type in the following command at a 

command prompt (or simply double click on the script file). 

 

GPUMeshMapper.exe /script <script filename> 
  

MeshMapper Scripts 

 

There are two sample scripts included with GPU MeshMapper: car_script.nms and 

ninja_script.nms. They are located in the  

GPU MeshMapper\samples\scripts directory and should produce similar 

results as their counterpart projects. 

 

Below is a different sample script that shows that you can generate maps for two 

different sets of models within the same script. 

 

Relative paths within the scripts should be relative to the directory that the script file is 

located in. 
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Example Script 

//------------------------------------- 
// Script file for GPU MeshMapper 
//------------------------------------- 
 
// Set Output Names and formats 
//------------------------------------- 
Set Height     = 512 
Set Width      = 512 
 
Set NormalMapFileName = "..\textures\CarNM.tiff" 
Set NormalMapFormat     = A16B16G16R16 
 
Set DisplacementMapFileName = “..\textures\CarDM.tiff" 
Set DisplacementMapFormat     = A8 
 
Set AmbientOcclusionMapFileName = "..\textures\CarAO.tiff" 
Set AmbientOcclusionMapFormat     = A8 
 
// Set Mesh Data 
//------------------------------------- 
Set LowResMesh  = "..\mesh\CarLow.nmf" 
Set HighResMesh = "..\mesh\CarHigh.nmf" 
 
 
// Set Generation Options 
//------------------------------------- 
Set NormalSelectionRule      = 1 
Set MaxRayCastDistance     = 20.000000 
Set MaxAngle                       = 180.000000 
Set Epsilon                            = 0.000100 
Set FavorLowResNormal     = True 
 
Set SuperSamplingQuality = 1 
Set AddTexelCorner           = False 
 
Set BoxFilter                                      = False 
Set ExpandTexels                               = 10 
Set InterpolateAcrossEmptyRegions  = True 
 
Set NormalInWorldSpace = False 
Set BentNormal                = False 
Set ApplyDetailMap         = False 
 
Set GenerateDisplacementMap = True 
Set DisplacementMapScale      = 16. 000000 
Set DisplacementMapBias        = -8. 000000 
 
Set GenerateAmbientOcclusionMap = True 
Set OcclusionSamplingRate              = 300 
Set UseGPU                                      = True 
 
// Trigger Computation 
//------------------------------------- 
Compute 

//------------------------------------- 
// Script file for GPU MeshMapper 
//------------------------------------- 
 
// Set Output Names and formats 
//------------------------------------- 
Set Height                        = 512 
Set Width                         = 512 
 
Set NormalMapFileName             = "..\textures\CarNM.tiff" 
Set NormalMapFormat               = A16B16G16R16 
 
Set DisplacementMapFileName       = “..\textures\CarDM.tiff" 
Set DisplacementMapFormat         = A8 
 
Set AmbientOcclusionMapFileName   = "..\textures\CarAO.tiff" 
Set AmbientOcclusionMapFormat     = A8 
 
// Set Mesh Data 
//------------------------------------- 
Set LowResMesh  = "..\mesh\CarLow.nmf" 
Set HighResMesh = "..\mesh\CarHigh.nmf" 
 
 
// Set Generation Options 
//------------------------------------- 
Set NormalSelectionRule           = 1 
Set MaxRayCastDistance            = 20.000000 
Set MaxAngle                      = 180.000000 
Set Epsilon                       = 0.000100 
Set FavorLowResNormal             = True 
 
Set SuperSamplingQuality          = 1 
Set AddTexelCorner                = False 
 
Set ExpandTexels                  = 10 
Set InterpolateAcrossEmptyRegions = True 
 
Set NormalInWorldSpace            = False 
Set BentNormal                    = False 
Set ApplyDetailMap                = False 
 
Set GenerateDisplacementMap       = True 
Set DisplacementMapScale          = 16.000000 
Set DisplacementMapBias           = -8.000000 
 
Set GenerateAmbientOcclusionMap   = True 
Set OcclusionSamplingRate         = 300 
Set UseGPU                        = True 
 
// Trigger Computation 
//------------------------------------- 
Compute 
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Syntax 

 

MeshMapper scripts can contain both comments and commands: 

 

• Comments Comment can start with // and end with end of line. 

Or /* to start and */ to end.   ( Just like C++ ) 

• Command  

 

There are two kinds of commands in MeshMapper scripts.  

 

- “Set <Param name>  = <Value>” to set parameter for map generation. 

( format, size, ambient occlusion etc ) 

- “Compute” to start computation of maps. 

 

Command Parameters 

 

• CurrentDirectory Sets current working directory. 

 

• LowResMesh Path name for low res mesh model file. 

 

• HighResMesh Path name for high res mesh model file. 

 

• Width Specify the width of normal map to be saved. 

 

//-------------------------------------------------------------------- 
// Model #2 
// 
// - Inherits all previous settings  
//   Just change whatever you want to change 
//-------------------------------------------------------------------- 
 
// set new models 
Set LowResMesh                  = "..\mesh\ninjaHead_low.obj" 
Set HighResMesh                 = "..\mesh\ninjaHead_high.obj" 
 
// set new map file names 
Set NormalMapFileName           = "..\texture\ninjaHead_NM.tiff" 
Set DisplacementMapFileName     = "..\texture\ninjaHead_HT.tiff" 
Set AmbientOcclusionMapFileName = "..\texture\ninjaHead_AO.tiff" 
 
// Since a displacement map scale and bias were already set 
// these maps will have the same scale and bias 
 
// Trigger computation 
Compute 
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• Height Specify the height of normal map to be saved.                              

 

• NormalSelectionRule 0 = Any Dist, 1 = Closest, 2 = Farthest, 3 = Mixed,    

 4 = Front Farthest, 5 = Front Closest. 

 

• FavorLowResNormal Set to True to favor high res normals that are closer in 

direction to the low res normal. 

 

• MaxRayDistance Set max ray distance for intersection. If this is set to zero,  

default value will be used. 

 

• MaxAngle Set max ray angle that will be used when considering if a 

high-res normal is generally in the same direction as the 

low-res normal. 

 

• SuperSamplingQuality Specify how many samples per texels when correlating 

the two meshes. (integer value 1-10). 

 

• AddTexelCorner        If set to True, 4 corners of a texel will be added for super  

 sampling. 

 

• NormalMapFileName The name to save the normal map as. 

 

• NormalMapFormat  Format to save normal map in. 

 

• NormalInWorldSpace Set to True, if you want normal in normal map to be 

 in world space.  If False, then normals will be in  

 tangent space. 

 

• BentNormal Set this True to calculate and store bent normals. 

 

• ApplyDetailMap Set this True to apply a detail map to the normal map. 

 

• DetailMapHeight Height in texels of the detail map. 

 

• DetailMapWidth Width in texels of the detail map. 

 

• DetailMapScalar Float scalar value to apply to the detail map. 

 

• DetailMapFileName Path and filename of the detail map to use. 
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• GenerateDisplacementMap Set this to True if you want to also generate a  

             displacement map. 

 

• DisplacementMapFileName  The name to save the displacement map as. 

 

• DisplacementMapFormat  Format to save normal map in. 

 

• DisplacementMapScale  Desired scale value of the generated displacement                     

             map. 

 

• DisplacementMapBias   Desired bias value of the generated displacement  

             map. 

 

• GenerateAmbientOcclusionMap  Set this to True, if you want to generate an   

             ambient occlusion map. 

 

• AmbientOcclusionMapFileName The name to save the ambient occlusion map  

             as. 

 

• AmbientOcclusionMapFormat     Format to save ambient occlusion map in. 

 

• UseGPU                   Set this True, if you want use GPU power to assist  

             computation of the ambient occlusion map. 

 

• OcclusionSamplingRate   If use GPU is enabled, this integer number (0 to    

            100) specifies the quality of sampling. 0 for lowest  

            quality and 100 is the highest. 

 

• MaxOcclusionDistance  Maximum distance two objects can be apart and  

             still impact occlusion on one another (ignored if  

             UseGPU is set to True). 

 

• ExpandTexels         Set integer value to specify how many pixels to  

             dilate normal map. 
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Map Composer Scripts 

Example 

 

Syntax 

 

MapComposer scripts can contain both comments and commands: 

 

• Command  

 

There are four kinds of commands in MapComposer scripts:  

- Compose <map type> 

//------------------------------------- 
// Script file for GPU MeshMapper Map Composer 
//------------------------------------- 
 
//------------------------------------- 
// First compose the normal maps 
//------------------------------------- 
Compose “normal map” 
 
Add “..\textures\car_door_NM.tiff” 
 
Add “..\textures\car_spoiler_NM.dds” 
 
Add “..\textures\car_body_NM.dds” 
 
// set post processing (dilation) 
Set ExpandTexels  = 10 
 
Save “..\textures\car_composite_NM.tiff” A16B16G16R16 
 
//------------------------------------- 
// Now compose displacement maps 
//------------------------------------- 
Compose “displacement map” 
 
Add “..\textures\car_door_DM.tiff” 
 
Add “..\textures\car_spoiler_DM.dds” 
 
Add “..\textures\car_body_DM.dds” 
 
// set post processing (dilation) 
Set ExpandTexels  = 10 
 
Save “..\textures\car_composite_DM.tiff” A16B16G16R16 
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This command must come before adding any textures to the map 

composer because it tells the composer what types of files it will be 

loading and adding together. The valid values for <map type> is either 

“normal map”, “displacement map”, or “ambient occlusion map”. 

- Add “<file name>” 

This command tells the map composer to load the specified file and 

add it to the composite map. The <file name> should be an absolute 

path to the file, or a path relative to the directory containing the 

script. 

- Set ExpandTexels = <value> 

This command tells the map composer to perform dilation on the 

generated maps.  If not specified a default value of 10 will be used. 

- Save “<file name>” <format> 

Save tells the MapComposer that no more maps will be added to this 

composite map and that the resulting map can be stored as the file 

named “<file name>” (again this can be absolute or relative). The final 

parameter, <format> indicates what internal format the composed map 

should be saved in. 

 

 

 

Support and Feedback 
 

Support for GPU MeshMapper can be obtained by email gputools.support@amd.com. 

We welcome all feedback too, so please let us know if you find the tool useful or if you 

have ideas for features that would be useful in future releases. 


